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Chapter 1
ODB++Design Viewer

You can use the Valor ODB++Design Viewer to examine the step of a product model that is 
stored in an ODB++ directory structure. You can open a step in an ODB++ directory structure 
that has been compressed into any of these file types: tgz, gz, Z, tar, or zip. You can view the 
graphic of the step and information about each layer of the step.
Release Notes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
Opening a Product Model Step. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

Opening the Step in Direct Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
Opening the Step in Database Mode. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

Filtering the Product Model List  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
Importing ODB++Design Data. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
ODB++Design Viewer Window  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
Viewing the Step and Repeat Table . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
Troubleshooting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25

Cannot Open ODB++Design Archive File on Windows 7. . . . . . . . . . . . . . . . . . . . . . . . . 25
ODB++Design Viewer on Linux 64 Bit Fails to Open a Product Model. . . . . . . . . . . . . . 26
Entry Point Errors Due to Wrong DLL Usage . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26

Release Notes
Resolved issues are listed for versions of ODB++Design Viewer since Version 2211.

Version 2211 Resolved Issues

ID Resolved Issue
EBS-136010 Error when using a double click to open a tgz file with ODB++ Viewer
EBS-135571 ODB++ Viewer will not open multiple files if product model names are 

the same
EBS-108855 ODB++ Viewer will not run if installed in C:\Program Files
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Opening a Product Model Step
When you first open ODB++Design Viewer, you choose the step you want to view. 
Subsequently, you can choose a different step to view, from within ODB++Design Viewer.
The procedure for opening a product model step depends on whether you are working in direct 
mode or in database mode.

• Direct mode — If your product models do not reside in a database, you can import each 
product model into the ODB++Design Viewer Product Model List and open a product 
model step from the list.

• Database mode — Some Valor applications maintain a database where ODB++ product 
models are cataloged. User access to these product models is managed by the 
application. If your product models reside in such a database, ODB++Design Viewer 
runs in database mode, and the Product Model List dialog box lists the product models 
in the database. You can open a product model that is cataloged in the database, or you 
can import a product model from an ODB++ directory structure or compressed file into 
the database, and then open it in ODB++Design Viewer.

When ODB++Design Viewer opens in database mode, it requires a username and 
password with rights to access the database. At some sites, the Valor application that 
maintains the database has been set up to bypass the login screen and to provide a valid 
username and password silently.

Opening the Step in Direct Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
Opening the Step in Database Mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

Opening the Step in Direct Mode
You can open a step in a product model that resides in an ODB++ directory structure, or in an 
ODB++ product model that has been compressed to one of these file types: tgz, gz, Z, tar, or zip.
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Procedure
1. Open the Product Model List dialog box.

The Product Model List dialog box opens.

The list displays the locations of the ODB++ product models that have recently been 
imported into ODB++Design Viewer.

You can expand a product model node to list the steps of the product model.

If you want to... Do the following:
Open ODB++Design 
Viewer and open the 
step

Open ODB++Design Viewer in one of the following ways:
• From the desktop icon

• From the Windows Start menu

Open a different step 
in ODB++Design 
Viewer

In ODB++Design Viewer, choose File > Open Job.
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By default, the Product Model List appears as a simple list of product models. Also 
available is the “details” mode, which lists the product model names and full paths. You 
can use the toggle button  to switch between the modes.

To restrict the Product Model List, type a string in the Product Model field.

To import a product model into the Product Model List, click Import.

To remove a product model location from the Product Model List, select it and click 
Remove.

2. In the Product Model List dialog box, double-click the product model or step you want 
to open, or select the step and click Open.

Related Topics
Filtering the Product Model List
Importing ODB++Design Data

Opening the Step in Database Mode
If you are working in database mode, you can open a product model that resides in an ODB++ 
database. You can import a product model from disk into the database. Product models can be 
imported from an ODB++ directory structure, or from one of these compressed file types: tgz, 
gz, Z, tar, or zip.
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Procedure
1. Open the Product Model List dialog box.

The Product Model List dialog box lists the product models in the database that was 
specified during installation.

You can expand a product model node to list the steps of the product model.

If you want to... Do the following:
Open ODB++Design 
Viewer and open the 
step

Open ODB++Design Viewer in one of the following ways:
• From the desktop icon

• From the Windows Start menu

When ODB++Design Viewer opens in database mode, it requires a 
username and password with rights to access the database. At some 
sites, the Valor application that maintains the database has been set up to 
bypass the login screen and to provide a valid username and password 
silently.

Open a different step 
in ODB++Design 
Viewer

In ODB++Design Viewer, choose File > Open Job.
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By default, the Product Model List appears as a simple list of product models. Also 
available is the “details” mode, which lists the product model names and full paths. You 
can use the toggle button  to switch between the modes.

To restrict the Product Model List, type a string in the Product Model field.

To import a product model into the database, click Import.

2. In the Product Model List dialog box, double-click the product model or step you want 
to open, or select the step and click Open.

Related Topics
Filtering the Product Model List
Importing ODB++Design Data

Filtering the Product Model List
You can restrict the Product Model List to show only product models whose name contains a 
constant string, or intervening characters at specific locations.

Prerequisites
You have opened the Product Model List dialog box as described in “Opening the Step in Direct 
Mode” on page 6 or “Opening the Step in Database Mode” on page 8.
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Procedure
Use the appropriate filtering option:

If you want to... Do this:
List product models 
containing a constant 
string

Enter the constant string in the filter.
For example, entering the string demo lists product models whose 
names include the string demo anywhere in the name.

List product models 
whose names may 
contain intervening 
characters at specific 
locations

Enter a string containing asterisks (*) to indicate where there may be 
intervening characters.
For example, entering the string demo*1 lists product models with 
names including the string demo, and then any intervening characters or 
no intervening characters, and a one, anywhere in the name.
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Importing ODB++Design Data
You can import an ODB++Design product model residing in an ODB++ directory structure or 
compressed to one of the following file types: tgz, gz, Z, tar, zip.

Prerequisites
You have opened the Product Model List dialog box as described in “Opening a Product Model 
Step” on page 6.

Procedure
1. In the Product Model List dialog box, click Import.

List product models 
whose names contain 
intervening 
characters at specific 
locations

Enter a string containing question marks (?) to indicate where there must 
be intervening characters.
For example, entering the string ?demo?1 lists product models with 
names including the string demo, and then some intervening characters, 
and a one, where the string demo is not at the beginning of the product 
model name.

If you want to... Do this:
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2. In the Open File or Select Directory with “Accept Dir” dialog box, use one of these 
options:

• To import a product model that resides in an ODB++ directory structure, browse to 
the directory containing the ODB++ structure and click Accept Dir.
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• To import a product model that is compressed to a file, browse to the directory 
containing the file, select the file, and click Open.

Results
The newly imported product model is added to the top of the Product Model List.
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ODB++Design Viewer Window
You use the ODB++Design Viewer to view the graphic of the product model step, and 
information about the layers of the step.

Figure 1-1. ODB++Design Viewer Window
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Objects
Table 1-1. ODB++Design Viewer Window - Panes 

Pane Description
ODB++ Layer List Used to choose layers to be displayed in the board 

viewer. 

The color of the cell in the layer column ( ) 
indicates the color in which the layer is displayed.
You can use the feature histogram or the component 
histogram of a layer to highlight groups of entities in 
the graphic area.
See “Using the Features Histogram to Select or 
Highlight Features” and “Using the Components 
Histogram to Select or Highlight Components” in 
Getting Started With ODB++Design.

Board Viewer pane Displays the graphic representation of the chosen 
layers.
The X and Y coordinates of the current mouse pointer 
position are displayed below the graphic.

Component Filter To display this pane, choose View > Component 
Filter or click the Component Filter tool ( ).
See Using the Component Filter Pane to Find 
Components” in Getting Started With 
ODB++Design.

Overview pane Use the Zoom area tool ( ) to drag a rectangle in 
this pane, or in the board viewer, to zoom to that area 
in the board viewer.
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Data bar The data bar at the bottom of the window displays 
information about highlighted features or 
components.
When multiple features or components are 
highlighted by double-click, the number of 
highlighted features or components is prefixed to the 
details of the first feature or component.

Table 1-2. ODB++Design Viewer Window - File Menu Options 
Tool File Menu Option Description
- Open Job Opens the Product Model List dialog box so you 

can open a product model whose steps you want 
to view. 

- Open Step Lists the steps of the current product model, so 
you can open the step you want to view. This 
option is unavailable if the product model has 
only one step.

- Exit Exit the ODB++Design Viewer.

Table 1-3. ODB++Design Viewer Window - Actions Menu Options 
Tool Actions Menu 

Option
Description

- View Orientation Open the “View Orientation” dialog box that 
enables you to rotate, mirror, or flip the board 
view.

Highlight
Highlight-2

Click the tool and click a feature to be 
highlighted in the colors set for Highlighted and 
Highlighted-2.
A symbol in the Color of features for each layer 
column of the ODB++ Layer List indicates 
whether one or two features are highlighted on 
the layer.

Table 1-1. ODB++Design Viewer Window - Panes  (cont.)
Pane Description
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Highlight NET Open the Highlight CAD Nets dialog box in 
which you can use two tabs to highlight CAD 
nets in two different colors.
Choose a tab and select a CAD net to be 
highlighted, or press Shift or Ctrl to select 
multiple nets.
The legend lists the names of the selected nets 
separated by semi-colons (;). The color in which 
the selected nets are displayed is indicated.

To view the features of the highlighted net on the 
currently displayed layers only, select the option 
“Show on viewed layers only”.

Clear Highlighted Clear highlighting applied using Highlight or 
Highlight-2.

Measure Between 
Points
Measure Between 
Features
Measure Between 
Nets
Measure Annular 
Rings

Opens a sub-menu where you can choose 
whether to measure between points, features, 
nets, or annular rings.
See “Measuring Distances” in Getting Started 
With ODB++Design.

Table 1-3. ODB++Design Viewer Window - Actions Menu Options  (cont.)
Tool Actions Menu 

Option
Description
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Snap Open the Snap dialog box in which you can 
define snap and grid options.

Table 1-4. ODB++Design Viewer Window - View Menu Options 
Tool View Menu Option Description
- Step & Repeat Table See “Viewing the Step and Repeat Table” on 

page 23.
Matrix Opens the “Matrix” window displaying the layer 

construction, layer types and subtypes, polarity, 
drill intersection with board layers (for drilled via 
holes), and sub-panel nesting.

Zoom In, Zoom Out Zoom in or zoom out.

Zoom Area Invoke the zoom area tool for drawing a zoom 
rectangle in the board viewer or overview pane.

Zoom PopView Display a magnified view of a section of the 
board. You can open more than one popview 
window at the same time. See “Zooming and 
Panning” in Getting Started With 
ODB++Design.

Zoom Home Zoom to a view that fits the board in the graphic 
area.

Previous Zoom Returns to the zoom factor that was in effect 
before the most recent zoom action.

Pan XY Open the Pan XY dialog box.

Type the X and Y coordinates to be brought to 
the center of the graphic area and click Goto.

Pan Left, Pan Right, 
Pan Up, Pan Down

Pan left, right, up, or down.
(shortcuts: keyboard arrow keys).

Table 1-3. ODB++Design Viewer Window - Actions Menu Options  (cont.)
Tool Actions Menu 

Option
Description
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View Properties Open the “Component Information” or “Feature 
Information” dialog box to view detailed 
information about the selected item.

Component Filter Open the component filter pane. See “Using the 
Component Filter Pane to Find Components” in 
Getting Started With ODB++Design.

Color Settings Open the “Colors” dialog box that enables you to 
set colors for displaying items in the graphic area.

- Component Options Open the “Component Display Options” dialog 
box that enables you to configure some aspects of 
how components are displayed in component 
layers.

- Show Populated 
Components Only / 
Show All 
Components

Toggle between showing all components and 
showing only populated components.

- Control Open the “Control” dialog box that enables you 
to control the display of data in the graphic area.

Table 1-5. ODB++Design Viewer Window - Help Menu Options 
Tool View Menu Option Description
- View Help Opens documentation for the ODB++Design 

Viewer. (shortcut: F1)
- About Displays ODB++Design Viewer version and 

system information.

Table 1-6. ODB++Design Viewer Window - Board Viewer Right-Click Menu 
Options 

Option Description
Zoom area Invokes the zoom area tool so you can drag a zoom rectangle in the 

board viewer pane or overview pane. 
Equivalent to clicking the Zoom Area ( ) tool.

Popview Display a magnified view of a section of the board. You can open more 
than one popview window at the same time. See “Zooming and 
Panning” in Getting Started With ODB++Design.

Table 1-4. ODB++Design Viewer Window - View Menu Options  (cont.)
Tool View Menu Option Description
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Measure Invokes the measure tool so you can measure the distance between two 
points.

Equivalent to clicking the Measure ( ) tool.
See “Measuring Distances” in Getting Started With ODB++Design.

Highlight Invokes the highlight tool so you can highlight a feature or component.
Equivalent to clicking the Highlight a feature or a component ( ) 
tool.

Clear highlighted Clears all highlighted features and components.
Equivalent to clicking the Clear Highlighted ( ) tool.

Toggle pile-up 
selection

Overlapping features make it difficult to choose an individual feature 
from among them. Pile-up selection mode provides a list of overlapping 
features that are at the board location at which you clicked, from which 
you can choose the feature you want.

Table 1-7. ODB++Design Viewer Window - Board Viewer Shortcuts 
Shortcut Description
Ctrl+a Invokes the Zoom area tool for one actuation. After you have dragged a 

rectangle in the board viewer pane or in the overview pane, the tool that 
was previously in effect is in effect.

Ctrl+d
down arrow

Pan down with 90% overlap.

Ctrl+e Click on the board graphic and press Ctrl+e to pan the board viewer pane 
to center that point in the pane.

Ctrl+h
Ctrl+Home

Zooms to a view that fits the entire board in the graphic area.

Ctrl+i
Page Up

Zooms in. Equivalent to clicking the Zoom In tool ( ).

Table 1-6. ODB++Design Viewer Window - Board Viewer Right-Click Menu 
Options  (cont.)

Option Description
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Ctrl+l
left arrow

Pan left with 90% overlap.

Ctrl+m Toggles between a four layer display and more than four layers.
Ctrl+o
Page Down

Zooms out. Equivalent to clicking the Zoom Out tool ( ).

Ctrl+r
right arrow

Pan right with 90% overlap.

Ctrl+Shift+d
Shift+down arrow

Pan down with 10% overlap.

Ctrl+Shift+l
Shift+left arrow

Pan left with 10% overlap.

Ctrl+Shift+r
Shift+right arrow

Pan right with 10% overlap.

Ctrl+Shift+Space Returns to the zoomed display in memory after zooming other areas.
Ctrl+Shift+u
Shift+up arrow

Pan up with 10% overlap.

Ctrl+Space Copies the current zoomed display to memory.
Ctrl+u
up arrow

Pan up with 90% overlap.

Ctrl+w Toggles the view of features among these modes:

full , outline , or width off 

Table 1-7. ODB++Design Viewer Window - Board Viewer Shortcuts  (cont.)
Shortcut Description
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Usage Notes
• Click one or more layers in the ODB++ Layer List to display them in the board viewer.

• To use the board viewer shortcuts, you must place the mouse pointer in the board viewer 
pane.

• Click the Toggle Units tool ( ) on the toolbar to toggle the measurement units 
displayed in the X and Y coordinates under the board viewer, and for the Measure tool, 
between inches and mm.

Viewing the Step and Repeat Table
If your product model contains step and repeat data, you can view panelization information in 
the Step & Repeat Table dialog box. 

middle-click The middle button can be used for these pan and zoom functions:
• Center in Graphic Area — Middle-click a point in the graphic area. 

The click point is panned to the center of the graphic area.
• Zoom Out — With the middle button, drag a diagonal up and to the 

right, ending at the point you want in the center of the graphic area.
• Zoom In — With the middle button, drag a diagonal down and to the 

left, ending at the point you want in the center of the graphic area.
• Zoom to Area — With the middle button, drag a diagonal down and 

to the right, so that the start and end of the line you drag define a 
rectangular area to which you want to zoom.

• Zoom Home — With the middle button, drag a diagonal up and to 
the left. The view zooms so that the whole board is displayed 
centered in the graphic area.

Shift+Home Zooms to a view that fits the highlighted component in the board area.
Equivalent to clicking the Zoom Home tool ( ).

Table 1-7. ODB++Design Viewer Window - Board Viewer Shortcuts  (cont.)
Shortcut Description
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Procedure
1. Choose View > Step & Repeat Table.

2. View the panelization information in the table:

Column Description
Step Name of the step.
Anchor Point Anchor point of the step.
Nx, Ny Number of steps in the X and Y directions.
Dx, Dy Distance between steps in the X and Y directions, in the indicated units 

of measure.
Angle Rotation angle for the step inside the panel.
Flip Indication of whether the step is flipped about the Y-axis.
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Troubleshooting
If the ODB++Design Viewer does not run as expected, review the suggested troubleshooting 
topics.
Cannot Open ODB++Design Archive File on Windows 7 . . . . . . . . . . . . . . . . . . . . . . . . 25
ODB++Design Viewer on Linux 64 Bit Fails to Open a Product Model  . . . . . . . . . . . . 26
Entry Point Errors Due to Wrong DLL Usage . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26

Cannot Open ODB++Design Archive File on 
Windows 7

If you cannot open a tgz file in ODB++Design Viewer, this is most likely caused by incorrectly 
set permissions with the database. This problem can also affect your vendors and make the files 
unusable to them as well.

Symptoms
When attempting to open a tgz file, Windows 7 displays this error message:

ERROR: gen_txt-6003-Unable to open file

Causes
Incorrect permission settings in Windows 7.

Solution
To correct the permission problems with the database, perform these steps:

1. In Windows Explorer, right-click the directory where your design resides and choose 
Properties.

2. Click the Security tab.

3. Click Edit.

4. Add Write privileges to the appropriate users. In this case, Everyone.

Note
This procedure provides only a temporary fix for the tgz file you are attempting to open. As 
a long-term solution, your IT department must ensure that permissions are set correctly for 

everyone.
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ODB++Design Viewer on Linux 64 Bit Fails to Open 
a Product Model

If the ODB++Design Viewer fails to open a product model (job), this is most likely due to 
compatibility issues between Valor NPI and the 64-bit Linux operating system.

Symptoms
The attempt to open a product model (job) fails. The Linux console log may display an error 
message. For example:

...
gunzip: stdin: invalid compressed data--crc error

Causes
The compress and expand utilities provided with the Valor NPI installation are incompatible 
with the 64-bit Linux system.

Solution
Enter the following command to install the 32-bit library:

yum install glibc.i686

If the problem persists, replace the gunzip, gzip, and compress files in the Valor NPI installation 
directory with their official versions available on your machine. Enter these commands:

cp /bin/gunzip <vNPI installation EDIR>/misc/

cp /bin/gzip <vNPI installation EDIR>/misc/

cp /bin/compress <vNPI installation EDIR>/misc/

Where <vNPI installation EDIR> is the path to your Valor NPI installation directory.

Entry Point Errors Due to Wrong DLL Usage
After successful install of ODB++Design Viewer, you may receive Entry Point Not Found 
errors when trying to run the program.



ODB++Design Viewer
Entry Point Errors Due to Wrong DLL Usage

Valor™ ODB++Design Viewer User Guide, vNPI 2211 27
November 2022

Note - Viewing PDF files within a web browser causes some links not to function. Use HTML for full navigation.

Symptoms
Examples of Entry Point Not Found error messages:

Causes
External QT DLLs are found in the C:\Windows\System32 location, which always has the 
highest PATH priority. As a result, the wrong DLL files are loaded when the software is started.
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Solution
Place the QT files supplied with the installation next to the main executable:

1. Copy all the files from:

../odbveiwer_<ver>/edir/nv/deps/valor_qt_514/lib

2. Paste the copied files to:

../odbveiwer_<ver>/get
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